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Dorico Marching Band Drum Mapping for VDL

Setup

This template has been created to enable a quick method of note entry for
snare drums, tenor drums, bass drums & cymbals in Dorico using all the
required notehead types that the players expect and as much of the VDL
playback as possible.

For the quickest note input we recommend a minimum four-octave
keyboard as the various notehead types have been mapped across the
lower two octaves, and then you can use the upper two octaves to enter
notes on the staves.

4 QOctave keyboard required

¥ YAMAHA

Changing noteheads / middle C Note input on to staff
percussion techniques

Figure 1. Ideally use a keyboard with at least four octaves.

You must start with the supplied Marching Drumline Dorico file as your
template. Itincludes the mapped noteheads and corresponding
percussion maps for each instrument.

The snareline, tenorline, bassline & cymbal instruments are already
assigned one to each player.

Make sure you set your Darico preferences for percussion note input (Edit
> Preferences menu on Windows; Dorico > Preferences menu on Mac) as
follows.

In the Note Input and Editing section:

Input onto kit or grid: ‘Use staff position’
Interpret as: ‘Treble G clef’

Input techniques from MIDI key: ‘36’
Number of keys for techniques: 24’
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Percussion Input

Key Commands

MusicXML Import

Note Input and Editi
Input onto kit or grid: Use percussion map

Note Input

Editing NG ECN Treble G clef :ELEIRUTES

Play

Input techniques from MIDI key: 36 i

P

Number of keys for techniques: 24

~

When 'Use staff position' is set, you can use the MIDI key specified for 'Input techniques from
MIDI key' and the note directly above to cycle through the playing techniques for the
instrument. The specified number of keys from the starting MIDI key choose specific playing
techniques.

Figure 2 - preferences dialog

This enables you to choose from the different playing technigues (shown
as different noteheads) by pressing notes on your MIDI keyboard starting
at note 36 (two octaves below middle C).

For playback setup, see the Playback section below.

Note Mapping (snare/tenor/bass)

For the snare, tenor and bass drums all the notehead mappings are
consistent.

Generally the white notes are the RH hits and the black notes to the left of
those keys are the LH hits. Therefore the default notehead for a RH hit
is note E and the LH hit is the key to the left, therefore Eb. In the same
way the ornate X rimshot is G and the LH rimshot X is F#. See figure 2
for full details.

Where available the Left and Right hits have been assigned so that while
you input the notes you can also define how they will playback if you wish.
All the drums have been mapped to the ‘manual’ versions of the VDL
patches — see the playback section of this document for details.

The first two keys (C and C#) are an alternate way to change to the
previous or next technique in the list.
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Figure 3 - Noteheads for drums mapped on a MIDI keyboard

Note input example — tenor drums

1. Start the caret using your favourite method (double-click; Enter or
Shift + N) and using the up and down arrow keys you will see
that that Dorico shows you the abbreviated name of each drum.

2. Setthe caret on a drum position e.g. the F space on the tenors
labelled T. Dr. 6.

3. On your MIDI keyboard with your left hand press E for a RH hit.

4. On your MIDI keyboard with your right hand press F above middle
C to enter a note for Tenor 1.

5. Continue choosing different note heads with your left hand and
entering notes for the 6 tenors drums using notes F, A, C, E, G
and A.

6. You can also use the other notes around the drums (D, E, G, B, D
and F) to enter e.g. double-stop on shells, stand hit, jam blocks
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and cowbell. Note that in cases such as the center B line for the
tenors there are two instruments (hand claps and low jam block)
and you can use the up or down cursor arrows to toggle between
them.

¥

L

0, W

Figure 4 - Notes entered for tenor drums using MIDI pitches.

To change note duration use the numbers on your computers QWERTY
keyboard as normal e.qg.

4 = 16" note

5 = 8" note

6 = quarter note
7 = half note, etc

Please note: If you enter a note on one of the staff positions that is not a
regular drum position the next drum note you enter will use the last drum
notehead you entered. You cannot change the drum notehead type
while the cursor is on a non-drum staff position. For example if you
entered a rimshot and then a cowbell the next drum note you enter will
also be a rimshot. If you want to enter a different type of notehead after
the cowbell you will need to use the up/down arrow keys to navigate back
to any regular drum position, and then you can choose the new notehead
type and continue entering notes.

Bass drums

Six bass drums are mapped to staff positions D, F, A, C, E and G with an
additional ‘Unison’ mapped to the center B line. You can choose to use
this, or display unisons as a chord.

Some noteheads have been mapped to maintain the consistency with
tenors and snares of notehead types across the MIDI keyboard even if
they aren’t commonly used on bass drums.

For full bass drum mapping, see the Appendix at the end of this
document.

Snare drums

Three snare drums are mapped. ‘Snare solo’ on the center line, ‘Snares
on’ on the C space and ‘Snares off on the A space, plus some additional
staff positions for instruments such as cymbals.

For full snare drum mapping, see the Appendix at the end of this
document.
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Consistent Mapping for Snare, Tenor and Bassline

As you can see above in from figure 2 the noteheads are mapped across
a 2 octave range in such a way that the same key will always give you the
same notehead whether you are writing for tenor, snare or bassline. The
labels also show where there are differences in playing techniques
(sounds) across the different drums.

The n/a label simply means that while the notehead has been mapped for
consistency during note input, those noteheads are not commonly used
on that drum.

Note Mapping (Cymbals)

The cymbal mapping has been created to match the drums as closely as
possible, e.g. moon, standard, ornate cross and cross noteheads are in
the same places, and the others mapped to fit with similar types e.g. flat
crash near orchestral crash and the crash chokes an octave above the flat
and orchestral crashes etc.

crash
vacuum scratch tap hi hat choke slow  fast
sizzle  out choke choke secco zing zing click
>
P
Q "I “
Cymbals ding orch flat sizzle scratch tap tap crunch crash whale sizz/  sizz/ sizz/
crash crash in edge halfway choke choke suck A suck B suck C

Figure 5. Noteheads for cymbals mapped on a MIDI keyboard

The cymbals have been mapped on to a 5-line staff as 16”, 18” and 20”
solo and ensemble/unison cymbals as shown in the Edit Percussion Kit
dialog (see figure 5).
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If you are only writing for one size of cymbal in your ensemble you can
edit the staff positions. In Setup mode expand the player card, hover

Edit Perc on Kit

Name: | Cymbal Shortname: | Cym. ® Drumset
m Grid Single-line Instruments

Marching Cymbals (1 line) (16") (Ensemble) (16")
Marching Cymbals (1 line) (16")

Marching Cymbals (1 line) (18") (Ensemble) (18")
Marching Cymbals (1 line) (18")

Marching Cymbals (1 line) (20") (Ensemble) (20")
Marching Cymbals (1 line) (20")

Stem direction and voice: J [ Slashes: | 4 |

Export Kit...

Figure 6. Cymbals mapped on to a 5-line staff.

over the Cymbal player and select Edit Percussion Kit. In the dialog
select and drag the players in to the staff positions you need and then
Apply and Close the dialog. This will also move any existing notes you
have already input on a cymbal staff.

You may also then wish to change the percussion map to only use the
size of cymbal you need — see the Playback > MIDI CC Messages -
Cymbals section of this document for details on how to change this.
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Navigating with a QWERTY keyboard

You can also navigate the staff for each instrument using the QWERTY
keyboard on your computer. This is not the fastest method, but useful
sometimes for editing or when a MIDI keyboard is not available.

Up/Down cursor arrows will move up and down the staff. (For some
staff positions e.g. the centre line on a tenor drum staff there are both
hand clap and jam block instruments assigned to the same staff position.)

When the caret is active, Alt + up/down arrows will cycle round all the
available techniques (if available) for that instrument e.g. Tenor Drum 3.

When a note is selected, Alt + up/down arrows will move the selected
note to a new staff position, keeping the notehead type where available.
If you want to change the notehead of a selected note use Shift + Alt +
up/down

Letters A-G will input ‘pitches’ on the staff as if it is a treble clef staff.

The letter Y (default pitch) will input a note at the current staff position of
the caret.

Numbers 1-9 will change note duration as normal.

Please note that insert mode (key command letter i) is slightly different on
percussion staves to other instruments. Insert mode on percussion
staves only affects the instrument/staff position you are editing. However
even without Insert mode you can still select one or more notes and use
Alt + left/right cursor arrows to move them.
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Playback

The included template also has the playback mapping defined using
Kontakt 6 and VSL.

If Dorico in Play mode you can see this if you click on the Edit ‘e’ icon in
the RH panel for the Kontakt instance.

@® KONTAKT
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g

Figure 7. VDL window with instruments loaded

The instruments are loaded automatically and percussion maps assigned
as show in the table below.
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Dorico Instrument Percussion Map VDL Patch Slot
Snare VDL Snare Line Manual/Manual Lite | SnareLine Manual 1
Tenor VDL TenorLine Manual/Manual Lite | TenorLine Manual 2
Bass VDL BassLine Manual/Manual Lite BassLine Manual 3
Cymbals VDL Cymbal Line all Cymbal Line All 4

The ‘Lite’ versions of the VDL patches use fewer layer for its sounds and
will therefore load more quickly and place less burden on your computer.
You can change to these patches in VDL if you wish.

MIDI CC Messages - Drums

Some drum and cymbal sounds require not only the correct note to be
pressed (and in some cases also a keyswitch), but also use the
modulation wheel (MIDI control change 1) in a certain position. In Dorico
v3.1 this is only possible by adding the MIDI control changes manually in
Play mode in the automation lane.

You can do this in the top lane for each drum type, e.g in the ‘Tenors’

automation lane instead of individually in the lane for each drum size as
shown below. Choose the line tool and draw a line to add the change
where you need it.

Setup Write Engrave m Print

c Flows

> Time
> Chords
Tenors
02 - Kontakt

Port: 1

2 £ i

MIDI CC il

Marching Tenor Drum 6

Cowbell 2

Hand Clap

JamBlock 1

JamBlock2

Marching Tenor Drum 5

Marching Tenor Drum 4
B} warching Tenor brum 3
Marching Tenor Drum 2
u Marching Tenor Drum 1
Double Stop on Shells

B stendnit
B vocatouss

v

<

[

Full score

Figure 8. CC1 messages added to the tenors
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Steinberg Media Technologies GmbH

iy O




@ steinberg

Creativity First

The table below shows the drum noteheads that will not automatically
trigger the correct sounds, and which CC message you would need to add

in Play mode.

VDL Patch Notehead Sound Required CC1

Tenorline Manual | Triangle (centre stem) Dread 32-63
Diamond Rod 64-95
Cross Rim 96-127
Slashed (filled) Stick shots 65-127

Bassline Manual Triangle (down left) Rim with rod | 65-127
Diamond (w stem slash) | Roll with rod | 65-127
Ornate cross Rim shot 33-64
Triangle (centre stem) Dread 65-95
Diamond Rod 96-127

MIDI CC Messages — Cymbals

For cymbals if you want to use all three sizes you need to set the
following CC messages.

VDL Patch Notehead Sound Required CC1
Cymbal Line All | All 20” 0-40

All 18” 41-80

All 16” 81-127

Alternatively, if you only want to use one size of cymbal you can change
the percussion map.

To do this, go to Play mode and in the RH panel click on the Endpoint

Setup cog for the Kontakt instance.
Percussion map to the size of cymbal you wish to hear.

messages are then required.

For the Cymbal in slot 4 change the

No CC
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Common Questions & Troubleshooting

Why do | not hear the correct sound during note input?

Currently the noteheads don’t audition correctly as you input them, but
they will playback correctly when you play your piece.

Why can | sometimes not change the technique?

If the caret is on one of the extra instruments e.g. dut or hand clap you
won’t be able to change the technique using your MIDI keyboard. This is
because the noteheads/techniques aren’t assigned to those instruments.
Entering a note for a drum will enter the last notehead/technique you
used. To change the notehead/technigue simply use the up/down cursor
arrow to move the caret to a drum position and then continue.

Why do some techniques (e.g. rim shot, rim, dreads) not
play the correct sound?

Some techniques require mod wheel / CC1 messages to be sent for
correct playback. This is not currently possibly using a percussion map,
so for correct playback see the Playback > MIDI CC Messages section.

Playback of rolls and mallet changes e.g. Puffy

At the moment the playback of rolls (e.g. tremolo slashes or buzz roll / z
on stems on stems) will repeat the normal sample and doesn’t use key
switches. If you have comments on this, please let me know. Similarly
changes to e.g. Puffy mallets currently may not yet playback.

How do | edit the notehead used for a particular style?

It is not advisable to edit the notehead styles. Please get in touch with
John if you wish to make changes. The reason is that the noteheads
have been mapped for consistency across as many drums as possible,
and each drum has to be defined individually. If you change or delete a
technique for one drum it will not affect any others, therefore giving
inconsistent results during note input. If you need to make a change you
would also need to make the same change for the other 14 drums.

How do I move a drum to a different staff position?

In Setup mode, expand the player card in the LH panel and use the Edit
Percussion Kit dialog. You can simply click and drag a drum to a new

staff position. This might be useful for e.g. cymbals if you only want to

use one of the available instruments on the center staff line.

How do | get the instruments from this template into my
Dorico file?

At the moment we suggest starting with our template and adding any
additional instruments to the supplied template file. If you have written
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music for other instruments in another Dorico project use File > Import >
Flows to import your music into the drumline template.

Can |l use the VDL note mapping to enter notes?

If you normally use the VDL note mapping across an 88 key MIDI
keyboard to enter notes you can also do this in Dorico for many of the
techniques. On Windows PC in Edit > Preferences > Note Input and
Editing (Dorico > Preferences > Note Input and Editing on Mac) in the
Percussion Input section you can choose ‘Use percussion map’.

Can I use drum pads or other midi devices or note input?

You can use other MIDI devices for note input, but it will depend on the
mapping of that device e.g. if your MIDI device can send MIDI pitches that
map to a treble staff you could use those instead of a MIDI keyboard to
enter notes, but you still may want to use a keyboard to change the many
available noteheads/techniques.

2020-03-31

Roll/buzz roll playback now added for z on stem for snare, tenor and
bass.

2020-04-16
Adding new players no longer additionally adds them to existing layouts.
2020-10-20

Fixed some master page issues in the parts, and set all paper sizes to
letter.

The following pages have the full list of available noteheads/techniques
and staff positions for each instrument.
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The ensemble, 18" and 20" cymbals are mapped the same but on the following staff positions.
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If only writing for one size of cymbal in your ensemble, see the Note Mapping section of the documentation.
For correct playback of all three sizes see the Playback > MIDI CC Messages - Cymbals section.



	Dorico Marching Band Drum Mapping for VDL
	Setup
	Note Mapping (snare/tenor/bass)
	Note input example – tenor drums
	Bass drums
	Snare drums
	Consistent Mapping for Snare, Tenor and Bassline

	Note Mapping (Cymbals)
	Navigating with a QWERTY keyboard
	Playback
	MIDI CC Messages - Drums
	MIDI CC Messages – Cymbals

	Common Questions & Troubleshooting
	Why do I not hear the correct sound during note input?
	Why can I sometimes not change the technique?
	Why do some techniques (e.g. rim shot, rim, dreads) not play the correct sound?
	Playback of rolls and mallet changes e.g. Puffy
	How do I edit the notehead used for a particular style?
	How do I move a drum to a different staff position?
	How do I get the instruments from this template into my Dorico file?
	Can I use the VDL note mapping to enter notes?
	Can I use drum pads or other midi devices or note input?

	Changes
	Appendices


